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Chapter 1. Overview of the agent
The IBM Tivoli Composite Application Manager Agent for Lotus Domino (product code GB) provides you
with the capability to monitor Lotus Domino.

IBM® Tivoli® Monitoring is the base software for the Lotus Domino agent.

IBM Tivoli Monitoring

IBM Tivoli Monitoring provides a way to monitor the availability and performance of all the systems in
your enterprise from one or several designated workstations. It also provides useful historical data that
you can use to track trends and to troubleshoot system problems.

You can use IBM Tivoli Monitoring to achieve the following tasks:

• Monitor for alerts on the systems that you are managing by using predefined situations or custom
situations.

• Establish your own performance thresholds.
• Trace the causes leading to an alert.
• Gather comprehensive data about system conditions.
• Use policies to take actions, schedule work, and automate manual tasks.

The Tivoli Enterprise Portal is the interface for IBM Tivoli Monitoring products. You can use the
consolidated view of your environment as seen in the Tivoli Enterprise Portal to monitor and resolve
performance issues throughout the enterprise.

See the IBM Tivoli Monitoring publications listed in "Prerequisite publications" in the Documentation
library topic for complete information about IBM Tivoli Monitoring and the Tivoli Enterprise Portal.

Functions of the monitoring agent
Resource monitoring

Collects monitoring information for Domino statistics, IntelliWatch statistics and events, and server
status. You can monitor Domino servers remotely through the local Domino server. Servers in the
same domain or cross-certified in a different domain can be remotely monitored. This includes the
ability to remotely monitor Domino Servers on platforms not currently supported.

Availability monitoring
Provides availability information separately for the monitored Domino Servers. The agent pings the
application to determine whether the Domino Server is available.

New in this release
For version 6.2.1 Fix Pack 2 of the Lotus Domino agent, enhancements were made since version 6.2,
including the fix packs.

• Provided a common installer for all operating systems that the agent supports.
• Added the self-describing agent capability to the Lotus Domino agent.

Components of the IBM Tivoli Monitoring environment
After you install and set up the Lotus Domino agent, you have an environment that contains the client,
server, and monitoring agent implementation for Tivoli Monitoring.

This Tivoli Monitoring environment contains the following components:
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Tivoli Enterprise Portal client
The portal has a user interface based on Java™ for viewing and monitoring your enterprise.

Tivoli Enterprise Portal Server
The portal server is placed between the client and the Tivoli Enterprise Monitoring Server and enables
retrieval, manipulation, and analysis of data from the monitoring agents. The Tivoli Enterprise Portal
Server is the central repository for all user data.

Tivoli Enterprise Monitoring Server
The monitoring server acts as a collection and control point for alerts received from the monitoring
agents, and collects their performance and availability data. The Tivoli Enterprise Monitoring Server is
also a repository for historical data.

Tivoli Enterprise Monitoring Agent, Lotus Domino agent
This monitoring agent collects data and distributes the data to the Tivoli Enterprise Monitoring Server,
Tivoli Enterprise Portal Server, Tivoli Enterprise Portal, Tivoli Data Warehouse, and Tivoli Integrated
Portal.

Multiple copies of this agent can run on the same system.

IBM Tivoli Netcool/OMNIbus
Tivoli Netcool/OMNIbus is an optional component and the recommended event management
component. The Netcool/OMNIbus software is a service level management (SLM) system that delivers
real-time, centralized monitoring of complex networks and IT domain events. Event information is
tracked in a high-performance, in-memory database and presented to specific users through
individually configurable filters and views. The software includes automation functions that you can
use to perform intelligent processing on managed events. You can use this software to forward events
for Tivoli Monitoring situations to Tivoli Netcool/OMNIbus.

IBM Tivoli Enterprise Console
The Tivoli Enterprise Console® is an optional component that acts as a central collection point for
events from various sources, including events from other Tivoli software applications, Tivoli partner
applications, custom applications, network management platforms, and relational database systems.
You can view these events through the Tivoli Enterprise Portal (by using the event viewer), and you
can forward events from Tivoli Monitoring situations to the Tivoli Enterprise Console component. If
you do not already use Tivoli Enterprise Console and need an event management component, you can
choose to use IBM Tivoli Netcool/OMNIbus.

IBM Tivoli Common Reporting
Tivoli Common Reporting is a separately installable feature available to users of Tivoli software that
provides a consistent approach to generating and customizing reports. Some individual products
provide reports that are designed for use with Tivoli Common Reporting and have a consistent look
and feel.

IBM Tivoli Application Dependency Discovery Manager (TADDM)
TADDM delivers automated discovery and configuration tracking capabilities to build application maps
that provide real-time visibility into application complexity.

IBM Tivoli Business Service Manager
The Tivoli Business Service Manager component delivers real-time information to help you respond to
alerts effectively based on business requirements. Optionally, you can use this component to meet
service-level agreements (SLAs). Use the Tivoli Business Service Manager tools to help build a service
model that you can integrate with Tivoli Netcool/OMNIbus alerts or optionally integrate with data
from an SQL data source. Optional components provide access to data from other IBM Tivoli
applications such as Tivoli Monitoring and TADDM.

IBM Dashboard Application Services Hub
The Dashboard Application Services Hub has a core set of components that provide such
administrative essentials as network security and database management. This component replaces
the Tivoli Integrated Portal component after version 2.2.

Tivoli Integrated Portal
Tivoli Integrated Portal helps the interaction and secure passing of data between Tivoli products
through a common portal. Within the same dashboard view, you can launch from one application to
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another and research different aspects of your managed enterprise. This component is installed
automatically with the first Tivoli product that uses the Tivoli Integrated Portal framework.
Subsequent products can install updated versions of Tivoli Integrated Portal. After version 2.2, this
component is replaced by the Dashboard Application Services Hub.

Agent Management Services
You can use IBM Tivoli Monitoring Agent Management Services to manage the Lotus Domino agent.

Agent Management Services is available for the following IBM Tivoli Monitoring OS agents: Windows,
Linux®, and UNIX. The services are designed to keep the Lotus Domino agent available, and to provide
information about the status of the product to the Tivoli Enterprise Portal. IBM Tivoli Monitoring V6.2.2,
Fix Pack 2 or later provides support for Agent Management Services. For more information about Agent
Management Services, see "Agent Management Services" in the IBM Tivoli Monitoring Administrator's
Guide.

User interface options
Installation of the base IBM Tivoli Monitoring software and other integrated applications provides various
interfaces that you can use to work with your resources and data.

The following interfaces are available:
Tivoli Enterprise Portal user interface

You can run the Tivoli Enterprise Portal as a desktop application or a browser application. The client
interface is a graphical user interface (GUI) based on Java on a Windows or Linux workstation. The
browser application is automatically installed with the Tivoli Enterprise Portal Server. The desktop
application is installed by using the Tivoli Monitoring installation media or with a Java Web Start
application. To start the Tivoli Enterprise Portal browser client in your Internet browser, enter the URL
for a specific Tivoli Enterprise Portal browser client installed on your web server.

Command-line interface
You can use Tivoli Monitoring commands to manage the Tivoli Monitoring components and their
configuration. You can also run commands at the Tivoli Enterprise Console event server or the Tivoli
Netcool/OMNIbus ObjectServer to configure event synchronization for enterprise situations.

Manage Tivoli Enterprise Monitoring Services window
You can use the window for the Manage Tivoli Enterprise Monitoring Services utility to configure the
agent and start Tivoli services not designated to start automatically.

IBM Tivoli Netcool/OMNIbus event list
You can use the Netcool/OMNIbus event list to monitor and manage events. An event is created when
the Netcool/OMNIbus ObjectServer receives an event, alert, message, or data item. Each event is
made up of columns (or fields) of information that are displayed in a row in the ObjectServer
alerts.status table. The Tivoli Netcool/OMNIbus web GUI is also a web-based application that
processes network events from one or more data sources and presents the event data in various
graphical formats.

IBM Tivoli Enterprise Console
You can use the Tivoli Enterprise Console to help ensure the optimal availability of an IT service for an
organization. The Tivoli Enterprise Console is an event management application that integrates
system, network, database, and application management. If you do not already use Tivoli Enterprise
Console and need an event management component, you can choose to use Tivoli Netcool/OMNIbus.

IBM Tivoli Common Reporting
Use the Tivoli Common Reporting web user interface for specifying report parameters and other
report properties, generating formatted reports, scheduling reports, and viewing reports. This user
interface is based on the Dashboard Application Services Hub for Tivoli Common Reporting 3.1 and on
Tivoli Integrated Portal for earlier versions.

Chapter 1. Overview of the agent  3



IBM Tivoli Application Dependency Discovery Manager
The Discovery Management Console is the TADDM client user interface for managing discoveries.

IBM Tivoli Business Service Manager
The Tivoli Business Service Manager console provides a graphical user interface that you can use to
logically link services and business requirements within the service model. The service model
provides an operator with a second-by-second view of how an enterprise is performing at any
moment in time or how the enterprise performed over a time period.

IBM Dashboard Application Services Hub
The Dashboard Application Services Hub provides an administrative console for applications that use
this framework. It is a web-based console that provides common task navigation for products,
aggregation of data from multiple products into a single view, and the passing of messages between
views from different products. This interface replaces the Tivoli Integrated Portal component after
version 2.2.

Tivoli Integrated Portal
Web-based products that are built on the Tivoli Integrated Portal framework share a common user
interface where you can launch applications and share information. After version 2.2, this interface is
replaced by the Dashboard Application Services Hub.

Data sources
Monitoring agents collect data from specific data sources.

The Lotus Domino agent collects data from the following sources:

Availability
Use the agent to monitor availability of the application and related components in the following ways:

• Perform application-specific tests (such as API calls).

Log files
The agent uses the file system to monitor application log files or other data files to gather metrics.
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Chapter 2. Installing and configuring the agent
Agent installation and configuration requires the use of the IBM Tivoli Monitoring Installation and Setup
Guide and agent-specific installation and configuration information.

To install and configure the Lotus Domino agent, use the Installing monitoring agents procedures in the
IBM Tivoli Monitoring Installation and Setup Guide along with the agent-specific installation and
configuration information.

If you are installing silently by using a response file, see "Performing a silent installation of IBM Tivoli
Monitoring" in the IBM Tivoli Monitoring Installation and Setup Guide.

With the self-describing agent capability, new or updated IBM Tivoli Monitoring agents using IBM Tivoli
Monitoring V6.2.3 or later can become operational after installation without having to perform additional
product support installation steps. To take advantage of this capability, see "Enabling self-describing
agent capability at the hub monitoring server" in the IBM Tivoli Monitoring Installation and Setup Guide.
Also, see "Self-describing monitoring agents" in the IBM Tivoli Monitoring Administrator's Guide.

Requirements
Before installing and configuring the agent, make sure your environment meets the requirements for the
IBM Tivoli Composite Application Manager Agent for Lotus Domino.

For information about requirements, see the Prerequisites topic for the agent in the ITCAM for
Applications Information Center (http://publib.boulder.ibm.com/infocenter/tivihelp/v24r1/topic/
com.ibm.itcama.doc_7.2.1/welcome_apps721.html).

For the most up-to-date information about system requirements, see the Software product compatibility
reports (http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity/index.html). Search for the
ITCAM for Applications product.

Upgrades for the Lotus Domino agent
Before installing and configuring the agent, make sure your environment meets the requirements for the
IBM Tivoli Composite Application Manager Agent for Lotus Domino.

The Lotus Domino agent can be upgraded locally or remotely.

• On Windows systems:

– For local upgrades, agent instances are upgraded automatically.
– For remote upgrades, the previous agent instances are lost during upgrade. A tool is provided to

restore the instances. Run the following script to restore and upgrade the instances.

%CANDLE_HOME%\InstallITM\updategbinstance.bat 

• On AIX®, Solaris, and Linux systems, agent instances are upgraded automatically

Installing language packs
The steps for installing language packs depend on which operating system and mode of installation you
are using.

To install a language pack for the agent support files on the Tivoli Enterprise Monitoring Server, the Tivoli
Enterprise Monitoring Agent, and the Tivoli Enterprise Portal Server, make sure that you installed the
product in the English language. Then, use the steps for installing on Windows systems, installing on
UNIX or Linux systems, or installing silently.
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Installing language packs on Windows systems
You can install the language packs on a Windows system.

Before you begin
First, make sure that you installed the product in the English language.

Procedure

1. On the language pack CD, double-click the lpinstaller.bat file to start the installation program.
2. Select the language of the installer and click OK.
3. In the Introduction panel, click Next
4. Click Add/Update and click Next.
5. Select the folder where the National Language Support package (NLSPackage) files are located.

Typically, the NLSPackage files are located in the nlspackage folder where the installer executable
file is located.

6. Select the language support for the agent of your choice and click Next. To make multiple selections,
press Ctrl and select the language that you want.

7. Select the languages that you want to install and click Next.
8. Examine the installation summary page and click Next to begin installation.
9. After installation completes, click Finish to exit the installer.

10. Restart the Tivoli Enterprise Portal, Tivoli Enterprise Portal Server, and Eclipse Help Server if any of
these components are installed.

Installing language packs on UNIX or Linux systems
You can install the language packs on a UNIX or Linux system.

Before you begin
First, make sure that you installed the product in the English language.

Procedure

1. Enter the mkdir command to create a temporary directory on the computer, for example, mkdir
dir_name. Make sure that the full path of the directory does not contain any spaces.

2. Mount the language pack CD to the temporary directory that you created.
3. Enter the following command to start the installation program:

cd dir_name lpinstaller.sh -c install_dir

Where: install_dir is where you installed IBM Tivoli Monitoring. Typically, the directory name
is /opt/IBM/ITM for UNIX and Linux systems.

4. Select the language of the installer and click OK.
5. In the Introduction panel, click Next.
6. Click Add/Update and click Next.
7. Select the folder where the National Language Support package (NLSPackage) files are located.

Typically, the NLSPackage files are located in the nlspackage folder where the installer executable
file is located.

8. Select the language support for the agent of your choice and click Next. To make multiple selections,
press Ctrl and select the language that you want.

9. Select the languages that you want to install and click Next.
10. Examine the installation summary page and click Next to begin installation.
11. After installation completes, click Finish to exit the installer.
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12. Restart the Tivoli Enterprise Portal, Tivoli Enterprise Portal Server, and Eclipse Help Server if any of
these components are installed.

Installing language packs on Windows, UNIX, or Linux systems silently
You can use the silent-mode installation method to install the language packs. In silent mode, the
installation process obtains the installation settings from a predefined response file. It does not prompt
you for any information.

Before you begin
First, make sure that you installed the product in the English language.

Procedure

1. Copy and paste the ITM_Agent_LP_silent.rsp response file template as shown in “Response file
example” on page 7.

2. Change the following parameter settings:
NLS_PACKAGE_FOLDER

Folder where the National Language Support package (NLSPackage) files are located. Typically,
the NLSPackage files are located in the nlspackage folder, for example: NLS_PACKAGE_FOLDER
= //tmp//LP//nlspackage.

PROD_SELECTION_PKG
Name of the language pack to install. Several product components can be included in one
language package. You might want to install only some of the available components in a language
pack.

BASE_AGENT_FOUND_PKG_LIST
Agent for which you are installing language support. This value is usually the same as
PROD_SELECTION_PKG.

LANG_SELECTION_LIST
Language you want to install.

3. Enter the command to install the language pack with a response file (silent installation):

• For Windows systems:

lpinstaller.bat -f path_to_response_file

• For UNIX or Linux systems:

lpinstaller.sh -c candle_home -f path_to_response_file

where candle_home is the IBM Tivoli Monitoring base directory.

Response file example

#     IBM Tivoli Monitoring Agent Language Pack Silent Installation Operation
# 
#This is a sample response file for silent installation mode for the IBM Tivoli 
#Monitoring Common Language Pack Installer.
#.
#This file uses the IBM Tivoli Monitoring Common Agent Language Pack with the 
#install package as an example. 
#Note:
#This response file is for the INSTALLATION of language packs only.
#This file does not support UNINSTALLATION of language packs in silent mode.
#-------------------------------------------------------------------------------
#-------------------------------------------------------------------------------
#To successfully complete a silent installation of the the example of Common Agent 
#localization pack, complete the following steps:
#
#1.Copy ITM_Agent_LP_silent.rsp to the directory where lpinstaller.bat or 
#lpinstaller.sh is located (IBM Tivoli Monitoring Agent Language Pack build 
#location).
#
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#2.Modify the response file so that it is customized correctly and completely for 
#your site.
#  Complete all of the following steps in the response file.
#
#3.After customizing the response file, invoke the silent installation using the 
#following command:
#For Windows:
#    lpinstaller.bat -f <path_to_response_file>
#For UNIX and Linux:
#    lpinstaller.sh -c <candle_home> -f <path_to_response_file>
#Note:<candle_home> is the IBM Tivoli Monitoring base directory.
#--------------------------------------------------------------------------------
#--------------------------------------------------------------------------------
#Force silent install mode.
#--------------------------------------------------------------------------------
INSTALLER_UI=silent
#---------------------------------------------------------------------------------
#Run add and update actions.
#---------------------------------------------------------------------------------
CHOSEN_INSTALL_SET=ADDUPD_SET
#---------------------------------------------------------------------------------
#NLS Package Folder, where the NLS Packages exist.
#For Windows:
#   Use the backslash-backslash(\\) as a file separator (for example, 
#C:\\zosgmv\\LCD7-3583-01\\nlspackage).
#For UNIX and Linux:
#   Use the slash-slash (//) as a file separator (for example, 
#//installtivoli//lpsilenttest//nlspackage).
#---------------------------------------------------------------------------------
#NLS_PACKAGE_FOLDER=C:\\zosgmv\\LCD7-3583-01\\nlspackage
NLS_PACKAGE_FOLDER=//tmp//LP//nlspackage
#---------------------------------------------------------------------------------
#List the packages to process; both variables are required.
#Each variable requires that full paths are specified.
#Separate multiple entries with a semicolon (;).
#For Windows:
#           Use the backslash-backslash(\\) as a file separator.
#For Unix and Linux:
#           Use the slash-slash (//) as a file separator.
#---------------------------------------------------------------------------------
#PROD_SELECTION_PKG=C:\\zosgmv\\LCD7-3583-01\\nlspackage\\KIP_NLS.nlspkg
#BASE_AGENT_FOUND_PKG_LIST=C:\\zosgmv\\LCD7-3583-01\\nlspackage\\KIP_NLS.nlspkg
PROD_SELECTION_PKG=//tmp//LP//nlspackage//kex_nls.nlspkg;//tmp//LP//nlspackage//
koq_nls.nlspkg
BASE_AGENT_FOUND_PKG_LIST=//tmp//LP//nlspackage//kex_nls.nlspkg;//
tmp//LP//nlspackage//koq_nls.nlspkg
#--------------------------------------------------------------------------------
#List the languages to process.
#Separate multiple entries with semicolons.
#--------------------------------------------------------------------------------
LANG_SELECTION_LIST=pt_BR;fr;de;it;ja;ko;zh_CN;es;zh_TW

Installing and configuring: agent-specific
In addition to the installation and configuration information in the IBM Tivoli Monitoring Installation and
Setup Guide, use this agent-specific installation and configuration information to install the Lotus Domino
agent.

Clearing the Domino Server password
On all supported operating systems, and for both local and remote configuration, you must clear the
password on the Domino Server being used by the agent for the agent to start. You can clear the
password at any time before you start the Lotus Domino agent.

About this task
Clear the Domino Server password.
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Procedure

1. Copy your server ID file (not the user ID file), to a Windows computer that has a Notes client. Each
Domino server has a server ID file, and if the password of the server ID file is not cleared, the Lotus
Domino agent cannot be started.

2. From the Notes client, click File > Security > Switch ID, and select the server ID file.
3. Click File > Security > User Security.
4. In Security Basics, select Change Password.
5. In the Change Your Password window, select No Password.
6. Confirm the change, and click OK to exit.
7. Copy your server ID back to your server computer. On UNIX and Linux systems, make sure that the ID

file is set to the correct user, group, and permissions.

Checking the Access Control List of the database
To use Database Corruption monitoring or the Database Space Usage monitoring feature, the Domino
server ID must be in the Access Control List of the database you want to monitor.

About this task
To check whether the Domino server ID is in the Access Control List, configure and start the Lotus
Domino agent, then check table Database Status > Database Corruption and Failover in the Tivoli
Enterprise Portal. If the State column is Operation not authorized or Access not authorized, the Domino
server ID is not in the Access Control List of the database.

Procedure

To add the Domino server ID to the Access Control List, complete the following steps:
1. Start the Domino Administrator client.
2. From the Domino Administrator Server pane, select the server that stores the databases.
3. Click Files and select one or more databases from the Domino data directory.
4. Click Tools > Database > Manage ACL.
5. Click Add.
6. Type the entry, or select it from the Domino Directory by clicking the button next to the list box. Select

Server as the user type, and select an access level. The access level must be at least at Reader level.
7. Click OK.

Configuring by using the Tivoli Enterprise Portal
Configuration of an instance of the monitoring agent can be done remotely (tacmd), locally on the
computer (itmcmd), or by using the Tivoli Enterprise Portal. This configuration requires values to be
defined for the agent to operate.

The following fields are defined for this agent:
Instance

This field uniquely defines the name that is seen on the monitoring server and portal server for the
Domino® Server being monitored. Usually the instance name is based off the Domino Server name or
domain so that the user can easily identify the Domino Server being monitored.

Monitored Domino Server Name
This field is the canonical or abbreviated Domino Server name for which you want to monitor. This
name can be a local server where the agent is installed or a remote server that is not located on this
computer.

Local hostname or IP address for Intelliwatch Events
This field is optional. Use this field if Intelliwatch events are going to be received by the monitoring
agent. If Intelliwatch events are going to be received by the monitoring agent, the host name or IP
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address of the local computer the monitoring agent is installed on must be entered. This host name or
IP address must have access outside the computer to the network.

Local port for Intelliwatch Events
This field is optional, but must be defined if the local host name or IP address for Intelliwatch Events
is used. This port, which can be any port number that is not used by other processes, is used for a
TCP/IP socket connection to receive Intelliwatch events. This socket must be open to the network
and not blocked by any firewall.

Full directory path to the local notes.ini file
Installing the Domino monitoring agent on a computer requires you to choose a local notes.ini file to
use so that the monitoring agent can issue API requests. The full path does not include the notes.ini
file name.

The interval to check database
This field indicates the interval to check the databases. The default value is 3600, which means that
the database check runs every 3600 seconds. If the field is set to 0, the database check never runs.

The databases or database directories to check
This field is optional. The default value is *, which means all the databases are checked. The field can
be used to specify which databases or database directories to check. Each path in the field, separated
by semicolons, is relative to the Domino data directory. The path can be a Domino database, a normal
Domino directory, or a Domino directory with *. For example, names.nsf; mail; mail2/* means the
database names.nsf, all the databases in mail, and all the databases in mail2 including its
subdirectories are checked.

The databases or database directories to exclude
This field is optional. The field can be used to specify which databases or database directories to
exclude. Each entry in the field, separated by semicolons, is relative to the Domino data directory. The
path can be a Domino database, a normal Domino directory, or a Domino directory with *. If a
database is excluded, it is not checked for corruption, failover, or space usage.The Database Status
workspace and any situation you set up is also excluded automatically. For example, names.nsf; mail;
mail2/* means the database names.nsf, all the databases in mail, and all the databases in mail2
including its subdirectories are not checked.

The configuration file to define which views of a database to check
This field is optional. It is a fully qualified configuration file path of the database view mapping. In this
configuration file, you can define which views of a database are checked. By default, only the default
view is checked. Use the following rules for setting up a configuration file:

1. There must be no space characters at the beginning of each line.
2. A line that begins with # is a comment.
3. The definition line is in the following format: PATH=VIEW[,VIEW]*

Where:

PATH is database path. There are three kinds of database paths:
*

All nsf databases on the Domino server.
test

All nsf databases in the test directory, not including sub directories.
test\*

All nsf databases in the test directory, including sub directories.

Note: The path separator can be either \ or /.

VIEW[,VIEW]* is database view list in which each view is separated by a comma.

Configuration file examples:

# test1.nsf
test1.nsf = view1, view2, view3
# the database directory
dir1 =  view_dir11, view_dir12
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# the directory including its subdirectory
dir2/* = view_dir21, view_dir22

If there are multiple definitions for a database, only the first one is used to check the database
views. For example, in the configuration file there are three definitions for the database readme
file:

help/readme.nsf = View1
help/readme.nsf = View2, View3
help/readme.nsf = View4

Only View1 of readme.nsf is checked.

Semicolon separated database replication strings to include

Strings that are separated by semicolons. Only reports indications that have database events and
events attributes that include these strings.

All replication events are collected. These events include manual, hit, and missed replication events.
For each replication event found, the string is scanned to see whether it matches one of the include or
exclude strings. If it matches the include string, it is kept in the returned set of rows. If it matches the
exclude string, it is eliminated from the returned set of rows. If no include or exclude strings are
configured, all replication events are returned.

Semicolon separated database replication strings to exclude

Strings that are separated by semicolons. Only reports indications that have database events and
events attributes that do not include these strings.

All replication events are collected. These events include manual, hit, and missed replication events.
For each replication event found, the string is scanned to see whether it matches one of the include or
exclude strings. If it matches the include string, it is kept in the returned set of rows. If it matches the
exclude string, it is eliminated from the returned set of rows. If no include or exclude strings are
configured, all replication events are returned.

Monitored Domino Server Log File
Name of log file to be monitored with fully qualified path.

Log file errors to search for
Vertical bar separated search strings. The default search strings can be updated or more search
strings added with | new_search_string.

Note: If you change the search string, the Lotus® Domino agent must be restarted for the new string to be
included in the search.

Windows configuration notes
After you installing the Lotus Domino agent and before you configure an instance, you must reboot the
Windows computer to update the system environment variables.

See “Configuration values” on page 12 for the values that are required to configure the Lotus Domino
agent agent.

See “Remote installation and configuration” on page 15 for information about configuring the Lotus
Domino agent remotely.

When you start the Domino Server on Windows, the server must be started as a Service so the monitoring
agent and the Domino Server can be in the same process tree.

Make sure that the notes.ini file contains the NotesProgram and the Directory keywords. The
Lotus Domino agent fails to start if the notes.ini file pointed to by the configuration parameter, Full
path to the local notes.ini file, does not contain the NotesProgram keyword. The NotesProgram
keyword is the path to the Lotus Domino base directory. The Directory keyword is used to determine
the path to the Domino Serverlock file.
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Changing the ping interval for determining the status of the Domino Server on Windows systesms
The Lotus Domino agent determines the status of the Domino Server by issuing the NSPingServer API
call. This API call runs by default every 30 seconds.

If you want to change the default 30-second interval, you can change the KGB_PING_INTERVAL value by
using the Manage Tivoli Enterprise Monitoring Services Console, right-clicking, and selecting Advanced >
Edit ENV File for the instance to be modified. The new value must be greater than the default of 30
seconds.

UNIX and Linux configuration notes
See “Configuration values” on page 12 for the values that are required to configure the Lotus Domino
agent agent.

See “Remote installation and configuration” on page 15 for information about configuring the Lotus
Domino agent remotely.

Make sure that the notes.ini file contains the NotesProgram keyword. The Lotus Domino agent fails
to start if the notes.ini file pointed to by the configuration parameter, Full path to the local notes.ini
file, does not contain the NotesProgram keyword. The NotesProgram keyword is the path to the Lotus
Domino base directory.

Configuring and starting the Lotus Domino agent as root user
On UNIX and Linux operating systems, you must configure and start the Lotus Domino agent as the root
user.

When you start the monitoring agent as root, the initialization process verifies that the correct softlinks
were established in the Domino installation directory, and switches the process to the Notes user ID
defined by the notes.ini file. If the correct softlinks were not established, the initialization process
creates the required softlinks. The final monitoring agent process runs as the Notes user ID when the
process communicates with the Notes Server.

Note: When you use itmcmd commands with multi-instance agents, you must include the -o parameter
to start or stop the instance.

itmcmd agent -o instance start|stop gb

Changing the ping interval for determining the status of the Domino Server on UNIX or Linux systems
The Lotus Domino agent determines the status of the Domino Server by issuing the NSPingServer API
call. This API call runs by default every 30 seconds.

The ping interval can be changed by changing the {instance name}|KGB_PING_INTERVAL|30| value
that is found in the kgbenv file that is in the $CANDLEHOME/config/.ConfigData directory. The new
value must be greater than the default of 30 seconds.

Uninstalling the monitoring agent

To make sure that configuration softlinks created in the Domino® Server install directory are removed, you
must use the kgbuninstall.sh script to uninstall the monitoring agent. Run the kgbuninstall.sh
script that is located at $CANDLEHOME/binArch/gb/bin/kgbuninstall.sh. The value for binArch
can be found by running the cinfo -i command.

Configuration values
For both local and remote configuration, you provide the configuration values for the agent to operate.

When you are configuring an agent, a panel is displayed so you can enter each value. When a default value
exists, this value is pre-entered into the field. If a field represents a password, two entry fields are
displayed. You must enter the same value in each field. The values that you type are not displayed to help
maintain the security of these values.

The configuration for this agent is organized into the following groups:
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Domino Server Configuration (config)
Null Description for section.

The configuration elements defined in this group are always present in the agent's configuration.

This group defines information that applies to the entire agent.

The databases or database directories not to check (KGB_CHECK_DB_EXCLUDE_PATH)
The Domino database paths separated by a semicolon that will not be checked.

The type is string.

This value is optional.

Default value: none

The databases or database directories to check (KGB_CHECK_DB_INCLUDE_PATH)
The Domino database paths separated by a semicolon that will be checked.

The type is string.

This value is optional.

Default value: *

The interval to check database (KGB_CHECK_DB_INTERVAL)
The interval in which the checking of database corruption and database usage runs.

The type is string.

This value is required.

Default value: 3600

The configuration file to define which views of a database are to check
(KGB_CHECK_DB_VIEW_CONFIG_FILE)

The full path to the configuration file of database view mapping.

The type is string.

This value is optional.

Default value: none

Local hostname or IP address for Intelliwatch Events (KGB_IWHOSTNAME)
The hostname or IP address of the local computer on which the agent is installed.

The type is string.

This value is optional.

Default value: none

Local port for IntelliWatch Events (KGB_IWPORT)
The port used for a TCP/IP socket connection to receive IntelliWatch events.

The type is string.

This value is optional.

Default value: none

Log file errors to search for (KGB_LOGERROR)
Each ICU regular expression separated by a vertical bar will be searched for.

The type is string.

This value is optional.

Default value: .*

Monitored Domino Server Log File (KGB_LOGFILE)
The name of the log file to be monitored with fully qualified path.
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The type is string.

This value is optional.

Default value: none

Semicolon separated database replication strings to exclude (KGB_LOG_EXCLUDE)
Only reports indications of database events and events attributes without these strings.

The type is string.

This value is required.

Default value: none

Semicolon separated database replication strings to include (KGB_LOG_INCLUDE)
Only reports indications of database events and events attributes including these strings.

The type is string.

This value is required.

Default value: none

Full path to the local notes.ini file (KGB_NOTESINIPATH)
The full path to the local notes.ini file.

The type is string.

This value is required.

Default value: None

Monitored Domino Server Name (KGB_SERVER)
The canonical or abbreviated Domino Server name that you want to monitor.

The type is string.

This value is required.

Default value: None

Remote monitoring configuration
• To monitor a Domino® server remotely:

The local Domino server must be in the same Domino domain as the remote Domino server.
–OR–
The local Domino server must be cross-certified with the remote Domino server if they are not in the
same Domino domain.

• A local Domino installation is required on the computer where the Lotus Domino agent resides, because
the Lotus Domino agent requires Domino libraries and the notes.ini file to initialize run time.

• There are no differences between configuring remote monitoring and local monitoring. To configure
remote monitoring, specify the remote Domino server name in the configuration fields; specify the other
configuration fields with the same information as local monitoring.

For example, if Domino server serverA/ibm is on computer A, and the Lotus Domino agent is deployed
on computer B, a Domino server must be installed on computer B to provide runtime libraries and a
notes.ini file. The Domino server on computer B must be in the same domain as serverA/ibm or
cross-certified if not in the same domain. During agent configuration, serverA/ibm must be used in the
server name field, while the notes.ini file path is the path of the notes.ini file on computer B, not
the notes.ini file path for the remote Domino server.
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Remote installation and configuration
You can install the monitoring agent remotely from the Tivoli Enterprise Portal or from the command line.

When you install the agent remotely, you must provide the configuration values for the agent to operate.
See “Configuration values” on page 12.

To install from the portal, see the IBM Tivoli Monitoring Installation and Setup Guide.

To remotely install or configure an agent through the Tivoli Enterprise Portal, application support for that
agent must be installed (Tivoli Enterprise Monitoring Server, Tivoli Enterprise Portal Server, and Tivoli
Enterprise Portal). Also, the agent bundle must be installed in the Remote Deploy Depot.

For information about displaying the configuration options that are available to use with the
configureSystem command, see "tacmd describeSystemType" in the IBM Tivoli Monitoring Command
Reference.

On Windows, if the Lotus Domino agent is installed remotely, you must run %CANDLE_HOME%
\InstallITM\updategbinstance.bat from the command line. You can run this script either before
or after you configure a Lotus Domino agent instance.

If you are using the command line, the following commands are examples of remote installation and
configuration for Windows operating systems:

Remote installation

tacmd addSystem -t GB -n Primary:sample.node.name:NT
-p  config.KGB_CHECK_DB_EXCLUDE_PATH=value
 config.KGB_CHECK_DB_INCLUDE_PATH=value
 config.KGB_CHECK_DB_INTERVAL=value
 config.KGB_CHECK_DB_VIEW_CONFIG_FILE=value
 config.KGB_IWHOSTNAME=value
 config.KGB_IWPORT=value
 config.KGB_LOGERROR=value
 config.KGB_LOGFILE=value
 config.KGB_LOG_EXCLUDE=value
 config.KGB_LOG_INCLUDE=value
 config.KGB_NOTESINIPATH=value
 config.KGB_SERVER=value
INSTANCE="inst1"

Remote configuration
The following example illustrates configuration by using all configuration variables. Typically, you specify
only the variables and values that you want to change.

tacmd configureSystem -m instance.name:hostname:GB
-p  config.KGB_CHECK_DB_EXCLUDE_PATH=value
 config.KGB_CHECK_DB_INCLUDE_PATH=value
 config.KGB_CHECK_DB_INTERVAL=value
 config.KGB_CHECK_DB_VIEW_CONFIG_FILE=value
 config.KGB_IWHOSTNAME=value
 config.KGB_IWPORT=value
 config.KGB_LOGERROR=value
 config.KGB_LOGFILE=value
 config.KGB_LOG_EXCLUDE=value
 config.KGB_LOG_INCLUDE=value
 config.KGB_NOTESINIPATH=value
 config.KGB_SERVER=value
INSTANCE="inst1"
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Appendix A. Documentation library
A variety of documentation is available for insert the short product name from the list.

IBM Knowledge Center contains topics of information for the product and links to relevant PDFs. In IBM
Knowledge Center, you can create a custom PDF that contains only the topics in which you are interested.
See the directions for Creating your own set of topics (http://www.ibm.com/support/
knowledgecenter/doc/kc_help.html#create).

Prerequisite documentation
To use the information about the components effectively, you must have some prerequisite knowledge.

The following information for Tivoli Monitoring is available in the IBM Knowledge Center (http://
www.ibm.com/support/knowledgecenter) to gain prerequisite knowledge:

• IBM Tivoli Monitoring Administrator's Guide
• IBM Tivoli Monitoring Installation and Setup Guide
• IBM Tivoli Monitoring High Availability Guide for Distributed Systems
• IBM Tivoli Monitoring: Installation and Configuration Guides for the following agents: Operating System

agents and Warehouse agents
• IBM Tivoli Monitoring: User's Guides for the following agents: Agentless OS monitors, Log File agent,

System p agents, Systems Director base agent
• IBM Tivoli Monitoring Agent Builder User's Guide
• IBM Tivoli Monitoring Command Reference
• IBM Tivoli Monitoring: Messages
• IBM Tivoli Monitoring Troubleshooting Guide
• IBM Tivoli Monitoring: References for the following agents: Operating System agents and Warehouse

agents
• IBM Tivoli Monitoring: Troubleshooting Guides for the following agents: Operating System agents and

Warehouse agents
• Tivoli Enterprise Portal User's Guide

Related documentation
The documentation for related products provides useful information.

See the following products in IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter/):

• Tivoli Monitoring
• Tivoli Application Dependency Discovery Manager
• Tivoli Business Service Manager
• Tivoli Common Reporting
• Tivoli Enterprise Console
• Tivoli Netcool/OMNIbus

Terminology that is relevant to IBM products is consolidated in one convenient locations at the IBM
Terminology website (http://www.ibm.com/software/globalization/terminology).
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Tivoli Monitoring Community on Service Management Connect
Service Management Connect (SMC) is a repository of technical information that is organized by
communities.

Access Service Management Connect at https://www.ibm.com/developerworks/servicemanagement.

For information about Tivoli products, see the Application Performance Management community (http://
www.ibm.com/developerworks/servicemanagement/apm/index.html).

Connect, learn, and share with Service Management professionals. Get access to developers and product
support technical experts who provide their perspectives and expertise. You can use SMC for these
purposes:

• Become involved with transparent development, an ongoing, open engagement between other users
and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

• Connect one-on-one with the experts to collaborate and network about Tivoli and the Application
Performance Management community.

• Read blogs to benefit from the expertise and experience of others.
• Use wikis and forums to collaborate with the broader user community.

Other sources of documentation
You can obtain additional technical documentation about monitoring products from other sources.

See the following sources of technical documentation about monitoring products:

• IBM Integrated Service Management Library (http://www.ibm.com/software/brandcatalog/ismlibrary/)
is an online catalog that contains integration documentation as well as other downloadable product
extensions.

• IBM Redbook publications (http://www.redbooks.ibm.com/) include Redbooks® publications,
Redpapers, and Redbooks technotes that provide information about products from platform and
solution perspectives.

• Technotes (http://www.ibm.com/support/entry/portal/software), which are found through the IBM
Software Support website, provide the latest information about known product limitations and
workarounds.

Conventions used in the documentation
Several conventions are used in the documentation for special terms, actions, commands, and paths that
are dependent on your operating system.

Typeface conventions

The following typeface conventions are used in the documentation:
Bold

• Lowercase commands, mixed-case commands, parameters, and environment variables that are
otherwise difficult to distinguish from the surrounding text

• Interface controls (check boxes, push buttons, radio buttons, spin buttons, fields, folders, icons, list
boxes, items inside list boxes, multicolumn lists, containers, menu choices, menu names, tabs,
property sheets), labels (such as Tip:)

• Keywords and parameters in text
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Italic

• Citations (examples: titles of publications, CDs, and DVDs)
• Words and phrases defined in text (example: a nonswitched line is called a point-to-point line)
• Emphasis of words and letters (example: The LUN address must start with the letter L.)
• New terms in text , except in a definition list (example: a view is a frame in a workspace that

contains data.)
• Variables and values you must provide (example: where myname represents…)

Monospace

• Examples and code examples
• File names, directory names, path names, programming keywords, properties, and other elements

that are difficult to distinguish from the surrounding text
• Message text and prompts
• Text that you must type
• Values for arguments or command options

Bold monospace

• Command names, and names of macros and utilities that you can type as commands
• Environment variable names in text
• Keywords
• Parameter names in text: API structure parameters, command parameters and arguments, and
configuration parameters

• Process names
• Registry variable names in text
• Script names

Operating system-dependent variables and paths

The direction of the slash for directory paths might vary in the documentation. Regardless of what you see
in the documentation, follow these guidelines:

• For UNIX or Linux, use a forward slash (/).
• For Windows, use a backslash (\).

The names of environment variables are not always the same in Windows and UNIX. For example,
%TEMP% in Windows is equivalent to $TMPDIR in UNIX or Linux.

For environment variables, follow these guidelines:

• For UNIX or Linux, use $variable.
• For Windows, use %variable%.

If you are using the bash shell on a Windows system, you can use the UNIX conventions.
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX  78758     U.S.A.
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Such information may be available, subject to appropriate terms and conditions, including in some cases
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated
through extrapolation. Actual results may vary. Users of this document should verify the applicable data
for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application programs conforming to
IBM‘s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:
© IBM 2009. Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
2009. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be
displayed.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
Copyright and trademark information (www.ibm.com/legal/copytrade.shtml).
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Intel, Intel logo, and Intel Xeon, are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or
both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.

Privacy policy considerations
IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
each user’s user name for purposes of session management, authentication, and single sign-on
configuration. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, See
IBM’s Privacy Policy at http://www.ibm.com/privacy and IBM’s Online Privacy Statement at http://
www.ibm.com/privacy/details the section entitled "Cookies, Web Beacons and Other Technologies" and
the "IBM Software Products and Software-as-a-Service Privacy Statement" at http://www.ibm.com/
software/info/product-privacy.
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